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Chapter 1 
 

INTRO 
 
 
This user manual represent an overview about Wac Designer software: it permits to use this 
software immediately. It shows information about the pattern tools and software function. 
 
 
 
1.1  About WAC Designer 
 
 
WAC Designer is a 32 bit Windows application, that permits to create patterns for textile machines. 
WAC Designer uses graphical tools to create pattern and several wizards allow to convert pattern 
into machine-format files. 
Moreover, WAC Designer permits to import and export the most common file formats, e.g. bitmap 
pictures for Windows, so it can be used also as pictures converter to create machine format files.  
 
 
1.2  Hardware & Software Requirement 
 
WAC Designer can be installed on every PC with Windows 9x/ME/2000/XP O.S. 
Also, PC must have installed a parallel port or USB port, in order to use the protection key, 
included in the software package. 
Screen Resolution must be at least 800x600 at 65.536 colors (16 bit). 
We suggest to use the resolution 1024x768 at 16,8 millions colors (32 bit). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
WAC Designer 1.1 July 2004 edition  Page 6 

 
 Sys Tec S.r.l. – ITALY – 

Chapter 2 
 

SETUP 
 
 
 
2.1  Setup  
 
To install the program, put the CD into your CD-ROM: the program will start automatically. 
If your system doesn’t support auto-run, click on Setup.exe on the main folder of CD. 
Setup File uses Windows Installer to copy the necessary files on your system. 
Windows Installer uses several wizards: to confirm the operations, click on “next” button to go to 
next step. 
On Windows 2000 and XP, the application will ask you to allow the execution of WAC Designer to 
all users. 
 

 Windows Installer needs to remove all the preview versions of WAC Designer 21st Century. 
 
 
 
2.2  KeySetup  
 
KeySetup.exe installs the driver to read the protection key. 
On “Setup Type”  page we suggest to use the option “Complete”. 
 
 
 
2.3  Installed File  
 
Setup will copy those files in your folder: 

• Adortl60.bpl   WAC Designer library 
• Bcbsmp60.bpl   WAC Designer library 
• Borlndmm.dll   WAC Designer library 
• Cc3260mt.dll   WAC Designer library 
• MacWiz.exe   wizard for the treatment of data 
• TextWiz.exe   wizard for languages translation 
• WACDes.exe   WAC Designer application 
• WACDes.mdb  database 
• Palette\ WACDes.wdp WAC Designer colors palette 
• Resource\CKM.mdb  CKM machine database 

 
Setup will create this: 

• Fill    folder for fill patterns 
• Palette    WAC Designer main folder 
• Patterns   Patterns folder  
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• Pictures   Folder for pictures of different format 
• Resource   WAC Designer reserved folder 
• Selvedge   Selvedge folder 

 
 
 
2.4  CD  
 
  
The main files are Setup.exe and KeySetup.exe 
In the folders “Common”, “program files” and “System32” there are the installation files. 
In the folder “program files \SYS TEC\ WAC Designer 21st Century Edition” there are the files 
show in the 2.3 paragraph. 
 
 
 
2.5  Sample  
 
Not available for this version. 
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Chapter 3 
 

OVERVIEW OF WAC DESIGNER 
 
 
3.1  Starting WAC Designer 
 
WAC Designer is a typical Windows application for painting.  
 
 

 
Picture 1 

 
 
Menu 
 
To access the menu voices it is possible to use the mouse or a sequence of keys.  
A list of the options is shown at the same time pressing the Alt key and the emphasized character of 
the single main voices, or the Alt key followed from the Enter key.  
The visualized menu can be changed using the horizontal arrows.  
In order to activate the single voice shown in the menu is necessary to press the correspondent 
emphasized character or the Enter key after to have the option selection through the vertical arrows. 
The important voices of the menu can be activated from keyboard pressing the associated keys, 
shown at the side of the text.  
For more information on the activation of the menu voices please refer to the handbook of the 
operating system. 
 
 
 

Menu 

Toolbar 

Selected tool 

Painting Tools 

Option for selected 
tool 

Reduced 
Palette 

Statusbar 

Colors percentage bar 

Picture Area 
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Toolbar 
These buttons in the toolbar allows the quick activation of the options. 
 
Painting tools 
The “Painting tools” allow to create or modify a pattern.  
You can find most of the common function of graphical application and specific function to define 
the textile item.  
The selected instrument appears in the area and it can be disable using the “Cursors” button.  
The other options of the selected graphical instrument appear under the list of graphical tools. 
For detailed info about how to use, please check the Chapter “PATTERN INSTRUMENTS”. 
 
Reduced Palette and color percentage bar 
The reduced palette is composed by 16 typical colors of the window graphical application. Under 
each color appear the code number, very important for the pattern work.  
Checking the button with a mouse pattern, you can see the selected color on the right and left click 
of the mouse and the color indicated by the cursor; you can see the three colors in the icon with the 
code number. 
The colors used in the pattern are inserted in the color percentage bar; scrolling the cursor over the 
colors, you will see the percentage of each color.  
A double click on a color in the percentage bar enables the “Gray” modality of pattern; a single 
click disable this function.  
When this modality is enabled all the colors of the pattern are changed in grey with exception of the 
selected color: so you can easily identify the pattern area where the color is used. 
See the paragraph 3.4 for more info of the colors. 
 
Status Bar 
In the status bar you can see information like cursor position and action to do in order  to proceed 
with the selected graphical tool. 
 
Picture area  
In this area you can see a picture at time. The opened pattern can be selected choosing the 
respective label in the bottom.  
Each pattern maintain its own feature of visualization, for example the zoom level and the grid 
activation. 
 
 
3.2  Language change  
 
To change the language select in the “Utility” menu, the option “Language”, then select the desired 
language in the list.  
Some word may remain in the original word even if you change the language because set from the 
software window. 
 
 
3.3  Option setting  
 
Select from “Utility” menu the option “Option”, it is possible to set up the rows generates from the 
application and the colors used as bottom of new pattern and grid. 
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3.4  Treatment of the pattern colors 
 
The WAC Designer application runs at 256 colors.  
This limitation is necessary because we have to assign a particular textile function to each color and 
also to avoid errors to the user in the treatment of colors.  
The codes from 0 to 255 given to single color help the user to define the textile item and to allow 
the execution of some automation. 
Coming from another Windows application trough the copy and past, the pattern colors are 
automatically adapted with the Wac Designer application.  
At the end of the operation it is possible that some color are different between the original one. 
 
 
 
3.5  Open, Save and close pattern files 
 
The Wac Designer allows to open many pattern files at the same time, also of different format. 
 

 Selecting the file “Open” from “File” menu, will open a window were you can open follow 
format file: 
 

• WAC Files (*.wac)  Pattern for machine that use WAC electronics 
• Fill Patterns (*.wdf)  Pattern to use with function “Fill” 
• Selvedge Patterns (*.wds) Pattern to use for selvedge area of expanded design 
• All Files (*.*)   Pattern for machine that use WAC electronics 

 

 The format of “WAC Files” is not necessary, in fact if you choose the generic format “All 
Files”, the application will ready all the files as “WAC Files”. 
 
 

 This icon allows you to open a preview for the selected file (for detail check the charter of 
design). 
 
Whit WAC Designer you can open the last files using the command “Reopen” from “File” menu. 
 

 To save the file, select “Save” from “File” menu. In this case the name and the destination 
will be the same. If you need to change them you have to you the command “Save as”. 
 
The file can be close use the command “Close” from “File” menu.  
The closing action is restricted to the selected file if the file is not the main in use, otherwise it will 
be closed all the pattern attached.  
 
3.6  Image access 
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With WAC Designer you can import and export pattern as Bitmap of Windows in 256 colors 
format. 
 

 To import an image you have to select “import image” from “File” menu, then, you have to 
select the desired Bitmap file. The dimension of pattern will be automatically adapted to the 
imported image. 
 

 To export an image you have to select “export image” from “File” menu, then you have to 
define the name and the position of the file. The WAC Designer use as default destination file the 
destination selected in the options page. 
 
 
 
3.7  Undo and restore of graphical operation 
 
The WAC Designer maintain a trace of all modification made to design. 
 

 To undo the last command select “Cancel” from “Edit” menu. 
 

 To restore the last command select “Repeat” from “Edit” menu.  
 
 
 
3.8   Cut, Copy and past 
 
With WAC Designer it is possible to change the graphical images with other application, example 
with WAC Paint for Windows. 
The function cut and copy are enabled only after selecting an area with the graphical instrument 
“Select Area”. You can also use the function “Select all” from “Edit” menu. 
 

 Cut, the image is cutted and placed in the Windows memory selecting the “Cut” from “Edit” 
menu. In this case the color of the area is replaced by the color selected in the right button of mouse. 
 

 Copy, the design is copied selecting “copy” from “Edit” menu.  
 

 Past, the image is past selecting “Paste” from “edit” menu.  
 
Using the function image copy WAC Designer convert the colors checking in the palette the similar 
color. It is possible that the colors change during this operation. The function past enable 
automatically the graphical instrument “Select Area”. 
 
 
 
 
 
 



 
WAC Designer 1.1 July 2004 edition  Page 12 

 
 Sys Tec S.r.l. – ITALY – 

3.9  Magnify and reduction 
 
For each design, WAC Designer gives 6 factors for magnification and 4 factors of reduction. The 
zoom level could be define as follow: 
 

• Selecting the desired factor from “Visualize” Menu 
• Selecting the desired factor from enabling list clicking on the arrow of zoom button in the 

tool bar 
• Clicking directly the magnify and reduction button of zoom factor in the tool bar 
• Clicking the key “+” to magnify and “-” to reduce the factor of zoom. 

 
The zoom factor is indicated from a scale and number called level of zoom. The level 1 indicate that 
the design is in scale 1/1. 
 

 The button in the middle of decrement and increment in the tool bar do not produce any 
effects in the zoom factor. The icon of this button correspond to the current zoom factor. 
  
3.10  Grid 
 
For each opened pattern with WAC Designer it is possible to enable the grid.  
The grid color is define in the option setup following the follow rule: each five point, horizontal and 
vertical, to trace the grid line is used the color “Grid 2”; each ten point is used the color “Grid 3”. 
 
The grid is not traced if the zoom is in 4 level.  
 

 The grid color can be choose from the reduced palette. 
 
3.11  Cursor 
 
WAC Designer gives two different type of cursor, the first can be used by mouse and the second 
can be used by keyboard.  
The cursors used by mouse can be changed selecting “Cursor” from “visualize” menu.  
The predisposed cursor is mentioned as: 
 

•  “System” 
•  “Cartesian axis” 
 

The “System” cursor is the one used in Windows, usually is an arrow. 
The “Cartesian axis” cursor is composed by two orthogonal lines that are extended to all the design. 
The cursor used by keyboard is called “cross”, it can be enabled when the user need. To move the 
cursor you have to use the arrows on keyboard and to select the function you have to use the space 
bar. 
The user can use firstly the mouse cursor and then for the same action can use the keyboard cursor, 
so it is possible to change the work modality; for example to make a line, if the user has some 
difficult with mouse, it can use the arrow keyboard for precision. 
 

 The coordinates shown in the status bar are referred to the last cursor position. 
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Chapter 4 
 

CREATING PATTERN WITH WAC DESIGNER 
 
 
Wac Designer permits to create new textile patterns and new graphical pictures, usually last ones 
are part of textile patterns. 
This chapter describes how to create patterns.  
 
 

 To create a new pattern, select “New” from “File” menu or click on this icon with your 
mouse. 
A wizard menu (pic. 2) will help you. 
 
 

 
Picture 2 

 
 
 
 
4.1  How to create a pattern for “Circular Knitting Machine”  
 
Patterns for “Circular Knitting Machine” are usually saved as .wac files, because they are a WAC 
private format files. 
On the “Wizard” screen, select “Circular Knitng Machine” and then “Next” 
On the new screen (pic. 3) you can input the data of your pattern.  
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Picture 3 

 
Then click “Finish” to create the new pattern with your data. 
With the data in picture 3, you will create a pattern called “Pattern1” with 100x100 points 
dimension: it will suitable for “AS-KS with selvedge and stripers” machine. 
 
 
 

 The information of your pattern can be changed before saving your file, but we suggest not 
to change the dimension of your pattern after you have created it. 
 
The filename is automatically suggested and the program verify that any other files with the same 
name are already opened in the application. 
 
After this, you will be able to use the graphical tools to create the pattern. 
You can also import a Bitmap picture, using the “Import Image” function in “File” menu: we 
remember that the picture must be in 256 color format. 
 
After you have created your picture, you must create the Expansion; using “Pattern Expansion” in 
“Tools” menu. 
In the screen you can see the colors used on the pictures. (pic. 4) 
 
Each color must be assigned to a fee, showed in the left-top table. 
You can use the “drag’n’drop”: click on the color and then drag it on your selected feed. 
 
In picture 5 you can se an example. 
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Picture 4 

 
 
 

 
Picture5 
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Then clicking on “OK” button, it will be create the expansion in a new window, using the same 
name of the pattern adding the suffix “.exp” 
 
 

 
Picture 6 

 
To create the WAC file it necessary to set the focus on the pattern window and then “Save” it. 
The file will be saved on the “WAC File” folder. 
Fro that folder you can save it on your disk.  
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4.2  How to create a fill pattern. 
 
A Fill pattern is a WAC private property file and it usually call as “.wdf”. 
To create a Fill pattern, start the “Wizard”, select “Others” and then “Next”. 
In the new screen (pic. 7) select “Fill Pattern” and insert your data. 
 
 
 

 
Picture 7 

 
Click “Finish” to confirm your data and create the new pattern.  
 
 

 The information of your pattern can be changed before saving your file, but we suggest not 
to change the dimension of your pattern after you have created it. 
 
The filename is automatically suggested and the program verify that any other files with the same 
name are already opened in the application. 
 
After this, you will be able to use the graphical tools to create the pattern. 
You can also import a Bitmap picture, using the “Import Image” function in “File” menu: we 
remember that the picture must be in 256 color format. 
 
To create the Fill pattern you need to save it using the “Save” function. 
IT will be create in the “Fill Pattern” folder: you can use this file when you select the “Fill” tool in 
the graphical toolbar. 
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4.3  How to create a selvedge pattern 
 
A selvedge pattern is a WAC private property file and it usually call as “.wds”. 
 
The operation to create a selvedge file is the same as a fill pattern file. 
But in the picture 7 you must select “Selvedge Pattern”. 
 
To create the file, you the “save” option from “File” menu: the fill will be save on the “Selvedge 
Pattern” folder. Selvedge files can be use when you are creating a new expansion for circular 
knitting machine. 
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Chapter 5 
 

PAINTING TOOLS 
 
 
5.1 Main function 
 
The drawing tools are accessed from the application main menu, under “Tools”, or simply via the 
buttons to the left of the window application. 
 

 The tools can only be used after a drawing area has been defined and activated. 
 

 No design instrument is enable if the button cursor or of cancel is visible. In this case any 
movement or action made on the design don’t modify the same. In any case there are an update of 
the mouse position and keyboard position (see paragraph “Cursors”). 
 
The selected instrument can be see in a n appropriate box, called “Activation” and the position is 
near the cancel button.  
Each tool has a specific way of operating, nevertheless the following rules are valid for all the tools 
with a choice of one or two points of the drawing area: 
 

• After the first click it is no longer necessary to keep the mouse button pressed down 
• The color used is the one associated to the mouse button pressed 
• The color associated to the other button is used for any filling in 
• Both colors can be changed before concluding the operation in progress 
• The colors can be chosen both from the small palette and from the complete one 
• The options of the tool can be chosen before concluding the operation in progress 
• It is possible to the zoom level during the operation in progress 
• It is possible to scroll through the image during the operation in progress 
• The tool options are shown in the area below the list of buttons of the tools 
• The tool is deactivated by selecting another one or by selecting the cancel button 
• The container of selection area is reported on the design clicking on the mouse outside the 

design or clicking the button Activation.  
 

 Any possible temporary trace – of a line for example – disappears by making the drawing 
smaller to below level 1; the operation in progress is not lost but it cannot be concluded before 
bringing the zoom to a level equal or greater than 1. 
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5.2  Pen  
 

 
 
The Pen tool permits the drawing to be modified pixel by pixel.  The color used is the one 
associated to the mouse button pressed. 
By keeping the mouse pressed the pixels can be written in a continuous way. 
 
Options 
No options are foreseen for this tool. 
 
 
 
5.3  Dropper  
 

 
 
The Dropper tool permits the acquisition of a color by taking it directly from the drawing. The 
mouse is positioned above one pixel of the drawing and mouse button is pressed. The color is 
associated to the button of the mouse pressed. 
 
Options 
No options are foreseen for this tool. 
 
 
 
5.4  Line 
 

 
 
The Line tool permits a line to be marked between any two pixels of the drawing. The color used is 
the one associated to the mouse button pressed. 
 
Options 
The style of the line can be chosen using the arrows located to the side of the style in use. The 
following styles are foreseen: 

• Continuous line 
• 1 to 1 starting from the first pixel of the line 
• 1 to 1 starting from the second pixel of the line 
• 2 to 1 
• 1 to 2 
• 3 to 1 
• 1 to 3 
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5.5  Fill 
 

 
 
The Fill tool permits an area to be filled with uniform color both with the color associated to the 
mouse key pressed or with a previously saved drawing.  
 
Options 
A box appears in a dedicated area that shows the drawing to use for filling the area. To insert the fill 
drawing for the first time or to modify it, it is sufficient to click with the mouse inside this box. Fill 
with drawing is in any case to enabled by checking the box near the “with image” text. 
The drawing is chosen via a dialog window, specialised for fill images. 
 

 To make a contained image the user have to use only the WAC Designer application. For 
more detail see Chapter “How to create a contained design”. 
 
 
 
5.6  Rectangle 
 

 
 
The Rectangle tool permits a rectangle to be marked between any two pixels of the drawing  
 
Options 
The shape can be marked in the following styles: 

• Just a border with the color associated to the mouse button pressed 
• Edge with the color of the mouse button pressed and filled with the color associated with the 

other mouse button 
• Edge and internal area with the same color associated to the mouse button pressed 

 
 
 
5.7  Ellipse 
 

 
 
The Ellipse tool permits an ellipsis to be marked within the rectangular area identified by any two 
pixels of the drawing.  
 
Options 
The shape can be marked in the following styles: 

• Just the edge with the color associated to the mouse button pressed 
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• Edge of the color of the mouse button pressed and filling inside with the color associated to 
the other mouse button 

• Edge and internal area of the same color associated to the mouse key pressed 
 
 
5.8  Square  
 

 
 
The Square tool permits a square to be marked between any two pixels of the drawing. The sides of 
the square have lengths coinciding to the shortest vertical and horizontal distances of the two pixels 
selected.  
 
Options 
The shape can be marked in the following styles: 

• Just a border with the color associated to the mouse button pressed 
• Edge with the color of the mouse button pressed and filled with the color associated with the 

other mouse button 
• Edge and internal area with the same color associated to the mouse button pressed 

 
 
 
5.9  Circle 
 

 
 
The Circle tool permits a circle to be marked in any area of the drawing. The circle can be marked 
both by defining the area in which it is included and by defining the radius, diameter or three points 
it must pass through. 
 
Options 
The marking method can be one of the following: 

• Circle included 
The area in which the circle must be included is defined; the diameter of the circle is the 
shortest length between the vertical and horizontal distances of the two pixels selected. 

• Circle defined with the radius 
The first pixel selected becomes the centre of the circle, while the second point determines 
the length of the radius. 

• Circle defined with the diameter 
The first pixel defined becomes a point of the circumference, while the second point 
selected determines the length of the diameter. 

• Circle by three points 
Three points are selected though which the circumference must pass. When the first two 
points are established, the circle is marked only if it passes through all three points. 

 
 
The shape can be marked in the following styles: 

• Just the edge with the color associated to the mouse button pressed 
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• Edge of the color of the mouse button pressed and filling inside with the color associated to 
the other mouse button 

• Edge and internal area of the same color associated to the mouse key pressed 
 
 
5.10  Diamond  
 

 
 
The Diamond tool permits a rhombus to be marked in the area between any two pixels of the 
drawing.  
 
Options 
The shape can be marked in the following styles: 

• Just the edge with the color associated to the mouse button pressed 
• Edge of the color of the mouse button pressed and filling inside with the color associated to 

the other mouse button 
• Edge and internal area of the same color associated to the mouse key pressed 

 
 
 
5.11  Polyline 
 

 
 
The Polyline tool permits marking a broken line in any area of the drawing. The action of the 
Polyline tool ends only by selecting the cancel button or by selecting another tool.  
 
Options 
The style of the single lines constituting the broken line can be chosen using the arrows to the side 
of the style in use; it can also be modified while drawing a broken line.  
The following styles are foreseen: 

• Continuous line 
• 1 to 1 starting from the first pixel of the line 
• 1 to 1 starting from the second pixel of the line 
• 2 to 1 
• 1 to 2 
• 3 to 1 
• 1 to 3 

 
 
 
5.12  Curves 
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The Curve tool permits a broken line to be drawn composed of curves in any area of the drawing. 
The color used is the one associated to the mouse button pressed. The action of the curve instrument 
ends only by selecting the cancel button or by selecting another tool.   
 
Options 
No options are foreseen for this tool. 
 
5.13  Spray  
 

 
 
The Spray instrument permits copying a predefined group of pixels into any area of the drawing. 
The instrument remains active after every copy. To deactivate it, select the cancel button or another 
instrument. 
 
Options 
The group can have one of the following densities: 

• Area 4 x 4 with 1 to 1 alternate 
• Area 8 x 8 with the typical arrangement of the WAC Designer 
• Area 8 x 8 with 1 to 1 alternate 

 
 
 
5.14  Edge Marking 
 

 
 
The edge marking tool permits an area of any shape to be selected and copied in any other area of 
the drawing. The selection ends when the broken line determining the selection area is closed. Once 
selected, the area can be dragged, even several times, by holding the left mouse button down within 
the area itself. Once the final position has been determined, the copying phase can be concluded, in 
other words we can cancel the current selection by clicking outside the “extend” selection area, 
oppure sul pulsante di attivazione. 
 

 The “extend” selection area includes all the points of the rectangular area, also outside the 
broken line, that includes the effective area. 
 
Options 
No options are foreseen for this tool. 
 
 
 
5.15  Area Select 
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The area select tool permits a regular, square or rectangular are to be selected, that can then be 
copied into another area of the drawing. Once selected, the area can be dragged, even several times, 
by holding the left mouse button down within the area itself. Once the final position has been 
determined, the copying phase can be concluded, in other words we can cancel the current selection 
by clicking outside the selection area, or selecting the activation button. 
 

 The Area Select tool permits copying and pasting drawings via the Windows memory 
exchange (clipboard). The colors of the drawings inserted in the clipboard are automatically adapted 
to the palette in use in the drawing. Drawings with more than 256 colors cannot be “pasted”. (See 
paragraph “Cut, copy and past”). 
 

 The Area Select tool is used to determine the action area of other instruments. 
 
Options 
No options are foreseen for this tool. 
 
 
 
5.16  Text  
 

 
 
The text tool permits inserting text into the drawing. Enabling this instrument will appear the option 
window were to insert the text 
 

 
Picture 8 

 
 

The current text settings are displayed in this window. Using a dedicated button it is possible to 
select the feature of all the Fonts made available by the Windows operating system. 
The text is transferred into the drawing inside a box by using the execution button. The text is then 
dragged, even several times, by holding the left mouse button down inside the box. One the final 
position is determined, the text can be definitively copied by clicking with the mouse outside the 
box, or the activation button. 
The feature of the text can be modified, even if it has already been transferred inside the box, by 
pressing the execution button again. 
The tool remains active and permits a different text to be inserted. 
 
 
Options 
This instrument have an appropriate options window (picture 8). The following information is 
respectively indicated in the area beneath:  

Executive button 

Font Change feature 

Text box 

Font current 
characterisitcs 
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• name of the Font in use 
• character size 
• bold activation 
• italic activation 

 
 

 The options window remains at the forefront until the text instrument is cancelled. If it is 
closed for any reason, it can be re-enabled by pressing the tool button again. 
 
 
 
5.17  Eraser  
 

 
 
The Eraser tool permits portions of drawing to be erased. The color used is the one associated to the 
right mouse button. By holding the mouse button down cancellation can be performed continuously.  
 
Options 
The “eraser” can be in one of the following sizes: 

• Small (2 x 2) 
• Medium (7 x 7) 
• Large (10 x 10) 

 
 
 
5.18  Color Change  
 

 
 
The Color Change tool permits drawing colors to be changed. After establishing the color to 
change, and the replacement one, we press the execution button to make to color change in the 
drawing.  
 

 The Area Select tool can be used to determine the area in which to make the color change. 
 
Options 
Two boxes are displayed in the options area separated by the execution button, represented by an 
arrow. The color to change is displayed in the left box while the replacement color is shown in the 
right box; the two colors are attributed by respectively pressing the left and right mouse buttons. 
The color can be acquired directly from the drawing or by choosing from the reduced or complete 
palette. 
If the tool is activated after establishing a selection area, the color change action area can be 
determined by selecting the following options: 
 

• Color change inside the area selected 
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• Color change outside the area selected 
• Color change in the entire drawing 
 

Obviously, if there is no area selected at the moment the tool is selected, the color change is 
executed on the entire drawing. 
 
 
 
5.19  Copy 
 

 
 
The copy instrument allows to copy a portion of design. Enabling this instrument it appear the 
window of options were to choose the modality of copy. 
 

 
Picture 9 

 
 

 The instrument Area selection is used to find the copy area. 
 
The first action of the instrument is  to put to disposition a copy of the selected area being 
overlapped it to that one it originates them. 
In the option window appear the initial coordinated and the dimension of selected area.  
To move the copy area to destination, it is possible to work in two way: 

- click the execution button after selected the coordinated of destination; 
- draging the copied area holding pressed the left button of mouse into the selected 

box.  
The dimension area of copy can be modify clicking the executive button after selecting the new 
dimension in the box.  
In the option window will appear all the copied colors; it is possible to disable the copy of some 
colors deleting the sign.  

Executing button 
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Selecting the option “Adapted” the original area will be reduced or magnifies. This function disable 
the function of align and repetition. 
 
After establishing the options you can copy the area clicking the mouse outside of the box of 
selection or on the executive button. 
 
 
 
5.20  Mirror 
 

 
 
The Mirror tool permits the drawing or a part of the same to be mirrored. The mirrored drawing is 
placed in a box and it can therefore be dragged, even several times, by holding the left mouse button 
down inside the box. Once the final position is determined, the operation can be concluded by 
clicking with the mouse outside the box. 
The mirroring modes can be changed at will before concluding the operation, oppure sul pulsante di 
attivazione.  
The mirroring modes can be changed at will before concluding the operation. 
 

 The Area Select can be used to determine the area in which the mirroring is to be performed. 
 
Options 
The following mirroring methods are foreseen: 

• Vertical mirroring 
• Horizontal mirroring 
• Vertical and horizontal mirroring 

 
 
 
 
5.21  Rotate  
 

 
 
The instrument  rotation allows to rotate a portion of design. After establishing the rotation degree, 
you have to click the executive key to enable the function.  
The rotation  can be modify before concluding the execution. 
The rotated design will be positioned in an box; you can drag it using the left button of mouse. After 
choosing the destination, to conclude the operation click outside the box or click on the execute 
button. 
 

 It is possible to use the instrument Selection area to determinate the rotation area.  
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Options 
In the option area will appear the four modality of rotation and the key of execution that is indicated 
graphically by an arrow. 
The first three options allow to rotate the design with follow angles-shot: 

• 90° 
• 180° 
• 270° 

The fourth option allows to execute a free rotation. The degree can be choose selecting with the 
arrow key; you will see immediately the effect on the design if the execute button is already be 
selected.  
You can also add a number between 0 and 365, but in this case if the button execute is already be 
selected, the rotation will be made only using the arrow key. 
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Chapter 6 
 

CIRCULAR KNITTING MACHINE 
 
In this chapter it will be showed the properties of the patterns for CKM.  
 
 
6.1  Properties 
 
You can access the properties of the pattern form “File”  “Properties” 
 
These are the properties: 

• General 
• Pattern 
• Expansion 
• File Option 
• Machine Model 

 
 
 
6.1.1  General 
 
In “General” it is possible to see the information about the file, as the dimension, the root, the 
creation date,… 
 

 
Picture 10 

 
The information can’t be changed 
 
.  
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6.1.2  Pattern 
 
On Pattern screen there are the information about he pattern as dimension, name,...  
 

 
Picture 11 

 
The name of the pattern is used also for expansion file. 
So if you change it from Pattern1 into Picture1, the expansion pattern will be automatically rename 
into “Picture1:exp”. 
The name must be at least of 8 types. 
 
The values “needles” and “courses” modify only the pattern file. 
You can’t change them if you have already created the expansion file. 
 
Comment is a free text box. 
 
 
6.1.3  Expansion 
 

 
Picture 12 

 
In the “Expansion” page you can find the information about the expansion pattern, as dimension 
and “selvedge dimension”  
The information can’t be modified. 
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6.1.4  Option File 
 
In this page, you can select which information you don’t want to insert in your WAC file and so to 
solve the problem of disk-size. 
 
 

 
Picture 13 

 
Selecting “Color exclusion in Expansion” the index of colors not used in the expansion pattern 
(usually saved in the WAC file) is set to 0. 
With this option, in many occasions we can save disk-size. 
When the dimension of the file exceed the disk-size, you can use the option “Multi-files enabled”, 
which excludes from the WAC file the main pattern and the associated data and can split the lines 
of the expansion in several files. 
In the example of picture 13 the pattern is split in 2 files each of 250 lines. 
 
 

 Using the “Multi-files enabled” option you can lose same data, not necessary for the 
execution of the pattern on the machine, but necessary for WAC Designer. 
So we suggest to save the file on your hard-disk before split it into many files. 
The split file can be opened with WAC Designer, but the pattern is managed as a single expansion 
pattern. 
 
 
 
 
6.1.5  Machine Model 
 
In the Machine Model page you can see the machine for which the pattern is been created. 
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Picture 14 

 
You can change the model and the needles, but after you have to save the pattern. 
“Details” button access to the detail of the machine model selected. 
  
 
 
6.2  Machine Model 
 
You can change the machine model selecting “ Machine model” from “Utility” menu. The data of 
machine are disposed as follow: 
 

• Model 
• Feature 
• Stripers 
• Selvedge 

 
 
6.2.1  Model 
 
In the model page you will see the name and the number of needles machine. 
 

 
Picture 15 
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The model can be choosen from the list clicking the arrow near the input box. 
The number of needles can be changed using the two arrow near the box or write the number. 
The value inserted are confirmed after clicking the “OK” button. 
 
 
 
6.2.2  Feature 
 
In the Feature page it is shown some information about machine model.  
 

 
Picture 16 

 
The command columns count indicate the dimension after the last needle of the expanded design. 
The needle origin can be placed on the left or on the right, while the line origin can on the top or 
bottom. 
The indicated data cannot be modified.  
 
 
6.2.3  Stripers 
 
In the Stripers page you can see if the stripers are enabled and the number of stripers for each feed.  
The information are not modifiable. 
 
 
 
6.2.4  Selvedge 
 
In the Selvedge page it is indicated if in the expanded design is enabled the function.  
You can see the minimum and maximum value of the area. 
The information are not modifiable. 
 
 
 
6.3  Expansion 
 
After having selected the pattern, start the expansion selecting “Expansion” from “tools” menu. 
Choosing the couplings of the colors and the options, through buttons is create a new pattern called 
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expanded pattern, were beyond to the subdivision of pattern line, it is possible to add automatically 
some tuck points, necessary to solve textile problem or to make some special effects.  
The created pattern will be saved together with the original one. To identify the expanded pattern, 
Wac designer gives the format “:exp” to the expanded pattern. The expanded pattern is always side 
by side the original pattern.  
 
 
6.3.1  Colors table 
 
Wac Designer expands the pattern with the colors indicated from the user on the table on the left top 
of the expansion window.  
The table is divided in column in accordance with the numbers of stripers.  
If the machine doesn’t have the stripers on the table there will be only two column, one fix that 
indicate the used feed for each line, and one that are indicated the colors.  
If the machine has stripers on the table there will be so column as stripers. 
To add colors on the table you have to use the function “Drag & Drop”; you can insert colors from 
the colors table and from the original pattern. Inside the color table, it is possible to change the 
position of the color using the function “Drag & Drop”.  
Clicking the right mouse button on the color table, it will appear a menu were it is possible to 
remove a single color, all colors in a line or all colors of the table. 
 

 The expanded pattern is saved as “WAC File”. If the vertical origin is bottom, the expansion 
of pattern will start from bottom and also the colors sequence. The user can change the sequence 
clicking the option “Color expansion from Top” if he want to expand from the top. In any case the 
pattern will be saved on “WAC File”. 
 
 
6.3.2  Pattern color list 
 
On the start expansion window WAC Designer checks the pattern and select all the used color.  
The grey color of the surrounding color area of the list indicate the correct allocation of colors.  
 
 
6.3.3  Expansion area 
 
On the start expansion widow WAC Designer set the horizontal and vertical limits to include all the 
pattern area.  
The user can select only a portion of the design adding the value or using the arrow to increase or 
decrease. 
 
 
6.3.4  Tucks point rules 
 
During the expansion, WAC Designer automatically inserts some tucks point that are rules from an 
area called “Tucks Rules”. The value indicated as follow: 
 

• “Interval” indicates how many point separate a tuck from the next one.  
• “Width” indicates how many tucks point in sequence to add. 
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• “Step” indicates how many number of movement point of tucks from pattern line and next 
one. 

 
The user can define the courses from tuck point line.  
The option with two vertical bar disables the value given to “Step”.  
With next two options you increase or decrease the tucks point position with value given to “Step”. 
 
 
 
6.3.5  Expansion modality “No inlay” 
 
In the “Option” page of expansion window you can define some modality to use during the pattern 
expansion. 
 
 

 
Picture 17 

 
With “No Inlay” modality each pattern line is expanded in many lines how many are the feeds set in 
the colors table (see paragraph 6.3.1).  
In the generated rows are inserted the colors related the feed, all the other colors are replaced with 
the color relating the out of work. Moreover are inserted the tucks points in consideration of the 
rules.  
The available option with this modality change the expansion as follow: 
 

• Enabling the option “Invert” the pattern is turn upside down horizontally and vertically 
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• The option “Long Stitch Break” erase the long point. Technically the tucks point and the  
welt point are exchanged with work point if the previous line of the needle correspond a 
work point of the same feed. 

• Changing the modality of tucks point adding, it is possible to deal the point that they would 
come inserted in particular position. 

The previewed modality are as follow: 
 

 No Change [OFF] The tucks point are inserted in accordance with parameters 
defined on  “Expansion” page (see paragraph 6.3.4) 

 Delete The tucks point are not inserted in lines that are not present work 
points 

 Displace [ON1] Tucks point near work point, if possible are moved from 1 needle 
on the right or on the left, otherwise they are erased. 

 Move [ON2] Tucks points near work point, if possible are moved of two 
needles on the right or on the left, otherwise they are erased 

 Delete / Displace The option Delete and Displace [ON1] are applied 
contemporaneously 

 
 
6.3.6  Expansion Modality “Inlay 1” 
 
The pattern can be expanded also with “Inlay 1” modality. 
 

 
Picture 18 
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Also for this expansion modality is available the “Invert” invert (see previous paragraph). 
It is possible to give a rules to each feed of colors table. To modify the values proceed as follow: 
 
 Select the feed line clicking inside of a line box 
 Modify the value on the bottom of the table 
 Update tables value clicking the key “Update” 

 
With this modality it is possible to define the number of expansion line applied to each main pattern 
line (see option “Knit Lines”). 
 
 
  
 
 
 
6.3.7  Selvedge area definition 
 
During the expansion WAC Designer, if the user need, add a selvedge opening horizontally a 
pattern. The data to enable the selvedge are inserted on the machine selection; for the machine were 
this selection is note preview the option is disable. In the machine data , are included the value limit 
of selvedge, minimum and maximum, and the initial amplitude.  
If the amplitude value is different then 0, on the expanded pattern is reserved a colored wrap 
representing the out of job. The point of area of selvedge are automatically substituted, during the 
expansion phase, from a sequence defined from the user on a particular pattern (see chapter 7). The 
selvedge pattern must be associated clicking the key “Fill Pattern”. 
The user can define a selvedge area on the top, bottom, left or right side. 
 
 
 
6.3.8  Key Apply 
 
Through the key “Apply”  is possible to execute the pattern expansion, a variant of  current 
expansion, without that the expansion window is closed.  
 
 
 
6.4  Visualization modality 
 
An expanded pattern can be seen as follow: 
 

 the pattern is shown in classic mode, the point is represented from colored pixels. 
 

 the pattern is shown in “Tremelloni” mode, the points are represented with 3 different 
symbols that are: in job; tucks and out of job.  
It is possible to view in this modality only if the zoom factor is higher then level 1. 
 

 the pattern is shown in “French” mode, the points are represented with 3 different symbols 
that are: in job; tucks and out of job. It is different from “Tremelloni” mode because the symbols 
are not the same. 
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6.5  Colors 
 
Beyond to the reduced palette (see paragraph 3.1) WAC Designer allows to choose a colors palette 
composed by 256 colors. The 256 colors palette can be enabled from main menu or clicking F12 
key.  
The colors selection is made clicking the left and right mouse key. It is not necessary to close the 
256 colors palette to use the choosed colors. 
On the window, it is possible to see the used colors for the execution of the tucks point and out of 
work. 
 
 
 
6.6  Control record 
 
After having expanded a pattern, it is possible to change the command of the expansion phase that 
automatically WAC designer makes.  
The user has to enable the editor of “Control record” from main menu or clicking F5 key.  
Here you will have some keys through which it is possible to move, delete, modify and add a new 
command. 
To modify a command you have to select it using the mouse click. The selected command is written 
with bold character. The command modify have to be executed in the appropriate section. The 
modification of command parameters, are reported on the command list only after clicking to the 
update key. 
To confirm any variation to command, the window is closed using the key “OK”. 
 
 
 
6.7  Stripers 
 
If  the user select a machine with stripers, the WAC Designer, on the expanded pattern, adds a wrap 
at the end of the pattern dedicated to command of pattern line.  
The color with index 0 usually indicate that no command are enabled. A line of this wrap is 
automatically fill up with stripers colors in use on the line. The color index depend of combination 
of stripers in use. The user can modify directly on the expanded pattern the commands colors; 
sometimes WAC Designer gives an editor of stripers command. 
In this editor is reported the expanded pattern without the command wrap.  
Near the pattern there are some columns that simplify the analysis and the modification of stripers 
commands.  
On the  “Color” column are reported only the colors corresponding the command.  
On the “Select” column is possible to execute a command group selection that is repeated to the end 
of the pattern (from the top to bottom); to select this function press “spread” button.   
The “Stripers” column is divided in so many columns as the commands to each line.  
The numbers indicate the stripers number and letter “F” indicate the authorization code.  
The stripers corresponding to command are shown in bold.  
To modify the command click the stripers icon or the authorization code; the command color is 
updated automatically.  
To confirm any variant made to commands, the window must be closed with key “OK”. 
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6.8  Preview 
 
Opening a file, WAC Designer open the typical window of Windows files, adding an area where it 
is shown a pattern preview.  
In this window a part of the pattern will fit all the available area for the preview.  
To see it with the real dimensions, the user has to press the appropriate key with a mouse click. 
 

 
Picture 19 

 
 
For “WAC File” the preview shows the expanded image and the original one.  
It is possible to select the images using the arrows of tool bar. 
Beyond the arrows in the tool bar it is available a key that open the property of pattern and a key to 
close the preview window. 
 
 
 
6.9  Print 
 
 
Printing a pattern, WAC Designer show a window where it is possible to select some print options. 
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Picture 20 

 
It is possible to select a printer from the system and modify the property of printer. 
The user can choose to print the pattern, the property of pattern or both. Printing the pattern is 
available follow options: 

 
 Grid Print the grid if the zoom level allows it 

 
 Axis 

Coordinates  
Print at the side of the pattern some info that allows to calculate the 
number of needle, with numerical indication on both sides 
 

 Commands Print of the command. This function is enable only if the machine have 
stripers. 

 
In this window it is possible to define with which zoom level the pattern must be print. 
 

 The visualization of pattern (see paragraph 6.4) in use during the activation of printing 
window, show the modality of pattern printing. 
 
WAC Designer execute the print of the showed pattern; in the pattern case, composed by expansion 
and pattern, the user have to select the area to print and then print it. 
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Chapter 7 
 

PATTERNS FOR FILL AND SELVEDGE 
 
 
In this Chapter  you will see the characteristics of pattern created for fill and selvedge. 
The pattern for fill can be used with the “Fill” tool to be placed in a uniform color area. 
The pattern for selvedge can be used during the expansion phase of a pattern to be placed on the 
defined selvedge area.  
 
 
 
7.1  Property 
 
You can enter to pattern property for fill and selvedge selecting “Property” from “File” menu. The 
property are divided as follow:: 
 

• Main 
• Design 

 
 
 
7.1.1  Main 
 
On the Main page is shown the property of file, the dimension and date of creation and last modify. 
The dimension and date data are not available till the file is saved. 
I dati mostrati in questa pagina non possono essere modificati. 
 
 
 
7.1.2  Design 
 
On the design page is shown the pattern characteristics, the name and the horizontal and vertical 
dimension. 
 
The name can be change and for the fill and selvedge pattern it is possible to indicate names without 
limits.  
The dimension indicated in needle and courses can be modify. 
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Picture 21 

 
7.2  Print 
 
Printing a pattern WAC Designer show a window where it is possible to select some printing 
options. 
The print options for fill and selvedge pattern are the same then the “circular machines” (see 
paragraph 6.9). 
The option “Commands” is always disabled because in the fill and selvedge pattern is not available 
the area dedicated to commands. 
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Appendix A 
 

ERROR MESSAGES 
 
 
 
A.1 Protection key 
 
WAC Designer can be used only if the user have a protection key.  
In the Cd-rom it is available the driver for protection key installation. Without drivers the 
application cannot enter to protection key.  
In case of problems, WAC Designer will show on a window one of follow sentence: 
 

 Key Setup failed Generic error. Maybe the driver is not installed  
 Key Data Access failed Access data error. Maybe the driver is not correctly installed. 
 Key not found Key not inserted correctly. 
 Read Key Error Read error. The key may be damaged. 
 Program not enabled WAC Designer disable. The key must be substituted or must be 

inserted the one supplied with the cd-rom. 
 Key access finished This message appear if WAC Designer was in trial and inform that 

the number of access are finished. 
 Rest access count:  This message appear if WAC Designer was in trial and inform the 

number of access available. 
 
 
 
A.2  Video Resolution  
 
WAC Designer the video setting to 256 colors or more. If the resolution is less then 256 colors, 
before closing the program will appear: 
 

Invalid Color Resolution: WAC Designer Application needs more than 256 colors. 
 
 


